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Глава 4.7. Векторизация растра с использованием Модуля ArcScan.
Общие сведения.

Модуль ArcScan – это набор инструментов для конвертации сканированных растровых изображений в векторные слои GIS. Этот процесс может быть выполнен как в автоматическом, полуавтоматическом, так и в ручном режиме.
Выбор способа зависит от качества растра, от поставленных задач и может быть изменен в настройках. Также настройки задают и желаемую форму результата – линия, полигон, shape или geodatabase и др.

Перед началом работы необходимо убедится, что Ваш пакет ESRI ArcGis Desctop содержит установленные расширения, в том числе и ArcScan. А так же, в том, что преобретенный тип лицензии позволяет пользоваться этим модулем. Включить (проверить) модуль ArcScan можно в меню Tools -> Extensions
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	Рис. 4.7.1. Включение ArcScan


Вызов панели инструментов Arscan осуществляется аналогично вызову любой другой панели инструментов View -> toolbars -> Arcscan
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	Рис. 4.7.2. Вызов панели ArcScan


Приступаем к работе.
В нашей работе часто возникает необходимость выполнить преобразование данных растрового изображения в векторный слой GIS. К примеру, топооснову или геологическую карту или карту любого другого назначения или отдельный элемент полезной нагрузки геологической карты (разломы, рудопроявления и т.д.). Обычно этот процесс включает в себя следующие шаги: 

· Сканирование изображения – получение растра

· Привязка (подгрузка) растра в ArcMAP

· Подготовка растра

· Цифровка (векторизация) растра – получение векторного слоя.

Отдельные шаги могут быть выполнены в сторонних программах (PhotoSHOP, EasyTrace) или непосредственно в ArcMAP с использованием модуля ArcScan.
Рассмотрим пример оцифровки горизонталей топоосновы без использования сторонних программ.
Подготовка растра.
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	Рис. 4.7.3. Фрагмент топоосновы


После сканирования топоосновы имеем файл формата *.jpg который, представляет собой сжатый растр с композитом трех цветов RGB. Как видно из рисунка, растр содержит фрагмент озера, линию сетки, тропинку, ручей, луг, подписи и высотные отметки, а также интересующие нас линии горизонталей рельефа – объект векторизации
Добавляем неподготовленный растр в ArcMap
File -> Add data -> выбираем файл растра -> add
Подтверждаем создание пирамид и соглашаемся с тем, что растр не привязан. Если растровое изображение состоит из композита слоев RGB, как в нашем случае, то необходимо добавить лишь один из трех слоев, как показано на рисунке. Иначе растр невозможно будет представить в виде бинарного изображения и ArcScan не будет работать.
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	Рис. 4.7.4. Добавление одного слоя композитного изображения


Результат добавления одного слоя показан на рисунке
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	Рис. 4.7.5. Результат добавления одного слоя композитного изображения


Обратите внимание, что слева в свойствах отображения слова стоит разброс значений в градации серого от 24х до 255.

Привязка растра.

Привязываем растр при помощи инструмента Georeferencing (см. раздел ХХХ)

В нашем случае, фрагмент растра был привязан к известной топооснове по двум точкам: вершине горы и истоку ручья. Для большинства растров привязку лучше выплнять до бинаризации изображения, так как лучше видны такие ориентиры как координатная сетка и другие жесткие точки. После бинаризации эти элементы частично затушуются или сольются с фоном, что осложнит привязку.
	[image: image6.png]R working - ArcMap -
File Edit View Bookmarks Insert Selection Tools Window Help

DEE& ¢ D@0~ |bfzw

4@ &0r v @@uz0@es Nu oM sal HE @) -

&) | ONRGarmin Menu ~ Open DNRGarmin

El

High: 255

Ium:u

& B 140308_topo_impilehtiipg
RGE

cator | X | 2]5] Tok [CrmeNowFemme = | Togee |

<

ERE R EEEE e
R, <f RS
2 et af

,maevauan N »
Georeferencing | Laver: iest 10p01pg - Band_1 Ho-Fa

MNRed: Band1
I Green: Band 2
MBlue Band3
Link Table A
Link XSource. ¥ Source. XMap.
1 397450,090623  6845737,552397  397450,290623  6845737,552397
2 398069,572663 6845389, 190598  398069,072668 6845353, 190598

En i

tondes | | o || Resiworronvaaet

I AutoAdist  Transformation: [1st Order Pobyamal (4 <!

Drawing v R () @ | Ao~ AT 1% [[o) Al

51 15| g | spatal Adjustment ~| K 1 2| 1 ke 9|

58,8

)

grkun %)
|

[ [31730,233°E 61°41'53984'N.






	Рис. 4.7.6. Привязка растра


Далее необходимо сделать изображение бинарным.

	[image: image7.png]Layer Properties 1
Generel | Source | Exent | Display Smbobgy | Felds | Jins & Relstes
Srou:
[Urique Values Pmnrstamvﬂ.smhss Import..
Svecned el Gassicaton
[Piscrete Color Value: | <VALUE> -] Manual
Normalzation:  [<rione> || gasses: o 7] I
1 2 f
. I
H I
‘Symbol | Range Label s I
-5 -2 .
[ o525 2350000001 -255 |7 l
H
i
u |
" l
™ Show diass breaks using cell values Display NoData as.
LT |
| ||






	Рис. 4.7.7. Бинаризация растра


Для этого в свойствах подключенного слоя выбираем на вкладке Symbology в поле Show пункт Classified, а в поле Classification выбираем из выпадающего списка количество классов равное двум. Затем нажимаем применить и видим, как поменялся растр. Если качество не устраивает, то в том же поле есть кнопка Classify, которая позволяет настроить границы бинаризации. Повторяем до тех пор, пока качество растра не станет приемлемым.
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	Рис. 4.7.8. Настройка классов бинаризации


Векторизация при помощи инструментов ArcScan происходит в режиме Edit. Для включения режима редактирования (Edit) необходимо добавить (или создать) векторный слой в который будут вноситься изменения (добавляться векторизованные линии). Свойства этого слоя должны отвечать свойствам векторизуемого объекта: полигон к полигонам, полилинии к полилиниям (как в нашем случае).
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	Рис. 4.7.9. Режим Edit


Как видно из рисунка, после добавления пустого слоя topo2 был включен режим Edit и панель ArcScan стала активной.
Применение автоматического режима.

Следующий шаг – это настройка параметров векторизации.
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	Рис. 4.7.10. Настройка параметров векторизации


Меню Vectorization - > Vectorization Settings

Это набор параметров для автоматической векторизации изображения.
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	Рис. 4.7.11. Параметры векторизации


Intersection Solution – параметр, отвечающий за действия при пересечении линий. Варианты: примыкание, пересечение, игнорирования. В нашем примере выбран последний.
Maximum Line Width – максимальная толщина возможной линии – параметр определения того, что считать линией.

Noise Level – уровень шума – влияет на то, какое количество ячеек растра программа будет считать шумом.

Compression Tolerance – параметр, отвечающий за загрубление линий. Чем больше значение, тем грубее линии, более ломанные, приближенные к простым формам. Чем ниже значение, тем ближе векторизованная линия будет к линии на растре. Влияет на количество и расстояние между узлами вектра.

Smoothing Weight – параметр смягчения линий.
Gap Closure Tolerance – определяет размер разрывов, которые следует игнорировать. Если отключить данный параметр, то буду создаваться отрезки от разрыва к разрыву. 

Fan Angle – угол поиска продолжения линии – регулирует направление продолжения векторизации. 
Hole Size – параметр определяющий размер дырок внутри (в теле) векторизуемых линий.

После изменения оного или нескольких параметров полезно нажать кнопку Apply и применить настройки. Это сразу отобразится в режиме Previw (предпросмотра), как на рисунке ниже, и будет видно какие объекты программа распозныет.
Дополнительно предлагается кнопка Styles, Которая позволяет сохранять и выбирать из ранее созданных шаблонов векторизации. Удобно при выполнении однотипных операций (топография, гидросеть, полилинии, полигоны и тп.)
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	Рис. 4.7.12. Пример подбора параметров векторизации, режим Preview


Программа позволяет регулировать и оптимально подбирать параметры и просматривать результат в режиме Preview, Как это показано на рисунке. Для включения режима Previwe и регулировки параметров его работы достаточно включить его в меню Vectorization.

После подбора оптимальных параметров можно запускать процесс автоматической векторизации путем нажатия Generate Feature в меню Vectorization 
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	Рис. 4.7.13. Результат автоматической векторизации


В результате мы полечили набор полилиний добавленный в shp-файл слоя topo2. Как видно из рисунка, векторизованы были также некоторые ненужные детали – точки, штрихи, особенно там, где горизонтали пересекались с надписями и линией сетки. При этом озеро, ручей, луг и др. не попали в целевой слой. Таким образом, полученный векторный слой хоть и требует дополнительного редактирования, но оно уже не столь трудоемко, как редактирование растра. Качество может быть дополнительно улучшено предварительной чисткой растра, а также более оптимальным подборам параметров автоматической векторизации.
Полуавтоматически и ручной режимы векторизации.
Исходный рисунок – фрагмент геологической карты. Представляет собой jpg-файл состоящий из композита RGB. Растр достаточно хорошего качества, является фрагментом современной геологической карты, выполненной в CorelDraw, затем распечатанной как приложение к отчету. Предположим, что нам достался только бумажный вариант карты и мы его сканировали.
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	Рис. 4.7.14. Фрагмент геологической карты


Как видно из рисунка, фрагмент карты содержит разноцветные полигоны (геология), цветные линии (металлогеническая нагрузка), желтые кружочки (рудопроявления), индексы, а также черные лини (разломы). Рассмотрим последовательность действий на примере разломов.

Загрузка растра.

Добавляем растр в ArcMap, как и в предыдущем случае только один слой композитного RGB-изображения. File -> Add Data
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	Рис. 4.7.15. Подключение исходного растрового изображения в ArcMap


Получаем не привязанные растр в оттенках одного цвета. Значения шкалы от 255 до 0. обратите внимание, что яркие цветные линии (металлогеническая нагрузка) уже практически не различимы (след. Рис.)
	[image: image16.png]@ working - ArcMap - Arclnfo

File Edit View Bookmarks Insert Selection Tools Window Help

DEE& 8% |0~ |Hmm o

dtor = Task: [Create NewFeature

T ERACCEEL T X

<+ y5.ckm

o o | Y I

Drawing = R O~ A~ |[am Jf0 - Bz u A~ &~

28°3117,994°E 0°02358'N






	Рис. 4.7.16. Растровое изображение в ArcMap


Затем, как и в предыдущем случае, выполняем привязку растрового изображения при помощи инструмента Georeferensing (см. раздел. ХХХ)
Подготовка изображения.

Далее бинаризируем изображение. Для этого в свойствах растрового слоя в поле Show выбираем Classified, а в поле Classification из выпадающего списка Classes – значение 2. Нажимаем Применить и получаем бинаризированное черно-белое изображение. Если качество изображения требует корректировке, то можно скорректировать диапазон значений цвета в точках, относящихся к классу 1 и к классу 2, как это описано в предыдущем примере.
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	Рис. 4.7.17. Бинаризация растрового изображения


Далее, как и в предыдущем примере, добавляем целевой слой, куда будут вноситься оцифрованные линии (в данном случае это будет слой Faults - разломы). Включаем режим Edit и вызываем панель ArcScan (правый клик на панель инструментов). Как видно из следующего рисунка, панель ArcScan активна и готова к работе.
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	Рис. 4.7.18. Режим Edit, Панель Arcscan активна


Берем инструмент Vectorization Trace – он позволяет в полуавтоматическом режиме трассировать линии на растре. Препятствием для остановки трассировки и для ожидания реакции пользователя могут быть разрывы в линиях, изменение толщин линий, пересечения линий. Как инструмент будет игнорировать эти препятствия, зависит от настроек (Vectorization -> Vectorization Settings). Выберем и векторизуем субширотный разлом в центральной части рисунка – видно, что он пересекается с другими разломами и с металлогенической границей (более жирная и прямая линия). Серия следующих рисунков показывает процесс оцифровки с востока на запад. Первый клик задает начальную точку, последующей задает направление – именно в этом направлении, программа ищет и выполняет трассировку, ориентируясь по ячейкам растра. Если на пути появляются препятствия, например ячейка с другим свойством цвета (белая) программа трассировка остановится и будет ожидать следующего клика мышкой, чтобы понять направления дальнейшей трассировки. Если препятствие будет невозможно преодолеть при существующих настройках трассировки, то программа выдаст об этом сообщение. Для продолжения необходимо будет скорректировать настройки, сделать из более мягким, либо принудительно указать программе в каком направлении двигаться дальше. Если сделать настройки мягче, то это приведет к трассировки нежелательных объектов – в нашем случае курсор будет перескакивать на геологические границы или на другие объекты. Для того чтобы принудительно указать направление движения трассировки не смягчая общих настроек достаточно выполнить следующий клик на продолжении линии с нажатой клавишей S на клавиатуре. Это будет знаком для программы форсировать препятствие и двигаться дальше в указанном направлении.
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	Рис. 4.7.19. Начало трассировки – преодоление пересечения линий
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	Рис. 4.7.20. Продолжение трассировки – впереди разрыв. Чтобы продолжить трассировку в западном направлении, преодолеть разрыв и избежать поворота трассировки на юг необходимо выполнить следующий клик с нажатой клавишей S на клавиатуре


Дойдя до конечной точки заканчиваем трассировку двойным щелчком мыши. В случае если двойной щелчок мыши не удобен и вместо завершения линии создает дополнительные узлы, уводя линию в сторону, можно в любой момент окончить рисовку нажав клавишу F2 на клавиатуре.
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	Рис.4.7.21. Окончание трассировки элемента


В результате получаем векторную полилинию созданную в заданном слое Faults. Сохраняем изменения.
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	Рис. 4.7.22. Результаты трассировки линии разлома


Общий результат трассировки выглядит для нашего примера так
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	Рис. 4.7.23. Результат трассировки разломов


При цифровке полигонов (замкнутых тел, скажем, геологических объектов), применяется тот же принцип. Ниже приведен пример трассировки фрагмента той же геологической карты. При бинаризации изображения корректируем диапазоны ячеек, которые будут отнесены программой к белым и черным до тех пор, кока наиболее четке не проявятся необходимые геологические границы (рис.)
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	Рис. 4.7.24. Настройка изображения, бинаризация


Далее создаем целевой полигональный слой в который будут добавляться оцифрованные объекты. Затем, пользуясь инструментом Vectorization Trace, аналогично вышеизложенному получаем векторизованные полигоны. (рис.)
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	Рис. 4.7.25. Процесс трассировки полигона


В итоге в целевом слое получаем векторный объект

	[image: image26.png]Q@ working2 - ArcMap - Arcnfo

File Edit View Bookmarks Insert Selection Tools Window Help

DEES 4 2BX o |$iFm
|| Editor || & | # = Task: [Create New Feature

LR OE&POR N QAHLOOEI o hOMh L @@ <1[& | onroomin
Target: [pagons

= [S]=]

Raster: [geolmap cutjpg - Band1 ~|

55 Lyers
= O faults demo

5 @ polygons

s
e
B ooncn - 55

Dy [Soure | Selcton
Drawing ~ K M~ Al [@wa

2873051,654°F 0°035,884°S






	Рис. 4.7.26. Векторизованный полигон


Возможности модуля ArcScan не ограничиваются описанными выше базовыми приемами. Важно отметить, что проводя весь комплекс операций непосредственно в программе ArcMap с модулем ArcScan мы избавляем себя от необходимость загружать и выгружать растр, многократно привязывать его или корректировать координаты уже оцифрованных объектов. Очень важно также, что подготовка изображения в ArcMap хоть и не столь совершенна как в Photoshop, но позволяет оперативно корректировать параметры отображения растра исходя из задач. Так в нашем примере понадобилась различная чувствительность бинаризации для трассировки разломов и геологических тел. При использовании сторонней программы это потребовало бы повторной загрузки и привязки растра, мы же обошлись оперативной корректировкой значений классов. 
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